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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description
Category

Description

Product Name

HP EliteBook 8740w Mobile Workstation

Processors

2nd Generation Intel® Core™ i7 processors, (support Intel Turbo Boost Technology):
●

i7-2620M, 2.7 GHz (turbo up to 3.4 GHz) dual-core processor, 4 MB L3 cache, 4 threads, 35W

●

i7-2630QM 2.0 GHz (turbo up to 2.9 GHz) quad-core processor, 6 MB L3 cache, 8 threads,
45W

●

i7-2720QM, 2.2 GHz (turbo up to 3.3 GHz) quad-core processor, 6 MB L3 cache, 8 threads,
45W

●

i7-2820QM, 2.3 GHz (turbo up to 3.4 GHz) quad-core processor, 8 MB L3 cache, 8 threads,
45W

●

i7-2920XM, 2.5 GHz (turbo up to 3.5 GHz) quad-core extreme processor, 8 MB L3 cache, 8
threads, 55W

2nd Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology Technology):
●

i5-2520M, 2.5 GHz (turbo up to 3.2 GHz) dual-core processor, 3 MB L3 cache, 4 threads, 35 W

●

i5-2540M, 2.6 GHz (turbo up to 3.3 GHz) dual-core processor, 3 MB L3 cache, 4 threads, 35 W

Chipset

Mobile Intel QM67

Graphics

Support for the following graphics subsystem graphics boards (all feature OpenGL driver support):

Display

●

AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

●

NVIDIA Quadro 3000M, N12E-Q1 2 GB dedicated GDDR5 video memory

●

NVIDIA Quadro 4000M, N12E-Q3 2 GB dedicated GDDR5 video memory

●

NVIDIA Quadro 5010M, N12E-Q5 4 GB dedicated GDDR5 video memory

●

Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) LED WVA without
webcam

●

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

●

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not
available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

●

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables)

Ambient light sensor
Memory

4 customer-accessible/upgradable memory module slots
Supports dual-channel memory
Supports up to 32,768 GB of system RAM
DDR3 1333 MHz, PC3-10600 SODIMMS
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Category

Description
Supports the following configurations:

Primary and
secondary storage

●

2048 MB total system memory (2048 × 1)

●

4096 MB total system memory (4096 × 1)

●

4096 MB total system memory (2048 × 2)

●

8192 MB total system memory (8192 × 1)

●

8192 MB total system memory (4096 × 2)

●

8192 MB total system memory (2048 × 4); only available on computer models equipped with a
quad-core processor

●

16384 MB total system memory (8192 x 2)

●

16384 MB total system memory (4096 x 4); only available on computer models equipped with a
quad-core processor

●

32768 MB total system memory (8192 x 4); only available on computer models equipped with a
quad-core processor

Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in)
solid-state drive for primary and secondary storage.
Support for RAID 0/1/5
Supports the following Serial ATA (SATA), 7200-rpm drives:
●

750 GB

●

500 GB

●

320 GB

●

320 GB self encrypting drive (SED)

Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):
●

256 GB

●

128 GB

Upgrade bay
Supports the following 12.7 mm 6.35 cm (0.5 in) tray load SATA optical drives:
●

Blu-ray R/RE DVD±RW SuperMulti Double-Layer (DL) Drive

●

±RW SuperMulti Double-Layer Drive

●

DVD±RW SuperMulti Double-Layer Drive

●

DVD-ROM Drive (defeatured combo)

Supports a 7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm
Supports "No Drive" option
Audio and video

Integrated dual-array microphone
High-definition (HD) audio with SRS premium sound
2 stereo speakers
Integrated 720p HD webcam

Modem
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56K V.92 data/fax modem
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Category

Description
Supports “no modem” option
Modem cable not included

Ethernet

Intel® 82579LM Gigabit Network Connection
S3/S4/S5 wake on LAN
NIC power-down technology
Ethernet cable not included

Wireless

Integrated wireless local area network (WLAN) options by way of the following wireless
modules:
●

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

●

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

●

Atheros HB112AGN 802.11a/b/g/n 3x3 WiFi Adapter

Three WLAN antennas (3) built into display assembly
Support for “no WLAN” option
Integrated wireless wide area network (WWAN) options by way of the following wireless
modules: (not available on computer models with Dream Color displays)
●

HP hs2340 HSPA+ Mobile Broadband Module

●

HP un2430 EV-DO/HSPA Mobile Broadband Module

WWAN antennas (2) built into display assembly (worldwide, 5-band)
Support for “no WWAN” option
Security provided by subscriber identify module (SIM) located inside battery bay
HP Integrated Module with Bluetooth 2.1+EDR Wireless Technology
Support for “no WPAN” option
External media card

One ExpressCard slot, supporting 16-bit and 32-bit (Cardbus) ExpressCard modules
Digital Media Card reader, supporting the following formats:
●

MultiMediaCard (MMC)

●

MultiMediaCard Plus (MMC+)

●

Secure Digital (SD) Memory Card

●

Secure Digital High-Capacity (SDHC) Memory Card

●

Secure Digital Extended Capacity (SDXC) Memory Card
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Category

Description

Ports

●

1394a (1)

●

Multi-pin AC port

●

Audio in (mono microphone)

●

Microphone input (stereo)

●

Audio-out (stereo headphone)

●

Display port (1.1a for NVIDIA, 1.2 for AMD)

●

Docking connector

●

eSATA/USB 2.0 combo

●

RJ-11 (modem)

●

RJ-45 (Ethernet, includes link and activity lights)

●

USB 3.0 (2)

●

USB 2.0 (2) 1 port with USB charging support

●

VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75 GHz (hot plug/unplug with
auto-detect)

●

Launch buttons (QuickWeb, WLAN on/off, Mute, Calculator)

Docking

Keyboard/pointing
devices

Supports the following docking stations:
●

HP 230W Docking Station

●

HP 230W Advanced Docking Station

●

HP USB 2.0 Docking Station

●

HP Essential USB 2.0 Port Replicator

●

HP LAN and USB Travel Hub

36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) without backlight
36.5 cm (14.4 in) full-size keyboard with separate numeric keypad, Dual Point (3 pointing stick
buttons and 3 TouchPad buttons) with backlight (not supported in Japan or Brazil)
Spill-resistant DuraKeys coating
Spill-resistant DuraPad coating on TouchPad
Gestures enabled by default - 2 finger scrolling, 2 finger zoom (pinch)
TouchPad supports vertical scroll zone
Taps enabled as default

Power requirements
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Supports the following AC adapters with localized cable plug support:
●

200W Slim Smart AC adapter

●

230W Slim Smart AC adapter

●

3-wire plug (with ground pin)
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Category

Description
Support for the following batteries:
●

8-cell, 2.8 Ah (83 WHr) Li-ion battery

●

8-cell, 2.8 Ah (75 WHr) Li-ion battery (available with 3 year warranty only)

●

Supports 9-cell (73 WHr) polymer, HP ST09 Extended Life Battery (does not support HP Fast
Charge)

●

Supports 9-cell 3.0 Ah (100 WHr) cylindrical battery, HP BB09 Ultra-Capacity Extended Life
Battery (does not support HP Fast Charge)

HP Fast Charge Technology
Security

Integrated fingerprint reader
Integrated Smart Card reader
Preboot authentication (password, Smart Card)
Supports security lock
Trusted platform module (TPM) v.1.2 and TPM enhanced drive lock
Full volume encryption

Operating system

Preinstalled operating systems:
●

Windows® 7 Home Premium 64 (select models only)

●

Windows 7 Professional 64 (select models only)

●

Windows 7 Professional 32 (select models only)

●

Windows Vista® Home Basic (Service Pack 2) (select models only)

●

FreeDOS

Operating system and Microsoft® Office preinstalled (not supported in Japan):
●

Windows 7 Professional 64 with Office 2010 Starter (select models only)

●

Windows 7 Professional 32 with Office 2010 Starter (select models only)

Restore media:
●

Windows 7 Professional 64 (select models only)

●

Windows 7 Professional 32 (select models only)

●

Windows 7 Home Premium 64 (select models only)

●

Windows 7 DRDVD (select models only)

●

Windows XP Professional 64 (service only)

●

Windows Vista Home Basic 32 (service only)

●

DRDVD Windows Vista (service only)

Certified:
●

Microsoft WHQL

●

Novell

●

SuSE Linux
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Category

Description
Web-only support:

Serviceability
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●

Windows Vista Business 64 (select models only)

●

Windows Vista Business 32 (select models only)

●

Windows Vista Enterprise 64 (select models only)

●

Windows Vista Enterprise 32 (select models only)

●

Windows XP Professional 64 (select models only)

●

Windows XP Professional 32 (select models only)

●

Windows 7 Ultimate 64 (select models only)

●

Windows 7 Ultimate 32 (select models only)

●

Windows 7 Enterprise 64 (select models only)

●

Windows 7 Enterprise 32 (select models only)

End-user replaceable parts:
●

Hard drive

●

Memory module

●

Optical drive

●

SIM

●

WLAN module

●

WWAN module
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External component identification

Top
TouchPad

Component

Description

(1)

Left pointing stick button

Can be used with the pointing stick and functions like the
left button on an external mouse.

(2)

Center pointing stick button

Can be used with the pointing stick and functions like the
center button on an external mouse.

(3)

Pointing stick

Moves the pointer and selects or activates items on the
screen.

(4)

Right pointing stick button

Can be used with the pointing stick and functions like the
right button on an external mouse.

(5)

Right TouchPad button

Functions like the right button on an external mouse.

(6)

Center TouchPad button

Functions like the center button on an external mouse.

(7)

Left TouchPad button

Functions like the left button on an external mouse.

(8)

TouchPad

Moves the pointer and selects or activates items on the
screen.

(9)

TouchPad on/off button

Turns the TouchPad on and off.

Top
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Lights

Component
(1)

Description
TouchPad on/off light

●

Off: The TouchPad is on.

●

Amber: The TouchPad is off.

(2)

Caps lock light

On: Caps lock is on.

(3)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

(4)

Num lock light

On: Num lock is on.

(5)

Wireless light

●

White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

●

Amber: All wireless devices are off.

●

Amber: Computer sound is off.

●

White: Computer sound is on.

●

On: The computer is on.

●

Off: The computer is off or in Hibernation.

(6)

(7)

Mute light

QuickWeb light

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help.
(8)
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Calculator light
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●

On: The Windows® calculator function is on.

●

Blinking: When the Calculator button is pressed, the
light blinks 4 times, and then the Windows calculator
opens.

Buttons and fingerprint reader

Component

Description

(1)

TouchPad on/off button

Turns the TouchPad on and off.

(2)

Power button

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button briefly to
initiate Sleep.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about your power settings:
●

Windows 7—Select Start > Control Panel > System
and Security > Power Options.

●

Windows Vista—Select Start > Control Panel >
System and Maintenance > Power Options

●

Or refer to the HP Notebook Reference Guide.

(3)

Wireless button

Turns the wireless feature on or off but does not establish a
wireless connection.

(4)

Volume mute button

Mutes and restores speaker sound.

Top
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Component
(5)

Description
QuickWeb button

●

When the computer is off or in Hibernation, press the
button to open HP QuickWeb.

●

When the computer is in Microsoft Windows, press the
button to open the default Web browser.

●

When the computer is in HP QuickWeb, press the
button to open the default Web browser.

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help. If your
computer does not have HP QuickWeb software, the button
does not perform any action or function.
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(6)

Calculator button

Opens the Windows calculator function.

(7)

Fingerprint reader

Allows a fingerprint logon to Windows, instead of a
password logon.

Chapter 2 External component identification

Keys

Component

Description

(1)

esc key

Displays system information when pressed in coMBination
with the fn key.

(2)

Function keys

Execute frequently used system functions when pressed in
coMBination with the fn key.

(3)

fn key

Executes frequently used system functions when pressed
in coMBination with a function key or the esc key.

(4)

Windows logo key

Displays the Windows Start menu.

(5)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(6)

Integrated numeric keypad

When the keypad has been enabled, the keys can be used
like an external numeric keypad.

(7)

num lk key

Enables/disables the integrated numeric keypad when
pressed.

Top
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Front

Component

Description

(1)

Supports the following digital card formats:

Media Card reader

●

Secure Digital (SD) Card

●

Secure Digital HC (SDHC) Card

●

Secure Digital XC (SDXC) Card

●

MultiMediaCard (MMC)

●

MultiMediaCardplus (MMC+)

(2)

Display release latch

Opens the computer.

(3)

Wireless light

●

White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: The computer is connected to external power and
the battery is charged from 0 – 90%.

●

White: The computer is connected to external power and
the battery is charged from 90 – 99%.

●

Blinking Amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: The battery is fully charged.

(4)

(5)

Power light

Battery light

(6)

Hard drive light

On: The hard drive is being accessed.

(7)

Speakers (2)

Produce sound.
NOTE: To use the SRS Premium Sound software, select Start
> All Programs > SRS Premium Sound.
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Right

Component
(1)

Description
Audio-out (headphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.
WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety and Environmental Notices.
NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

(2)

Audio in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3)

USB charging port

Connects an optional USB device.

(4)

USB 2.0 port

Connects optional USB devices.

(5)

External monitor port

Connects an external VGA monitor or projector.

(6)

Smart Card reader

Supports optional Smart Cards.

(7)

Upgrade bay (optical drive shown)

Reads and writes (select models only) to an optical disc.
NOTE: The upgrade bay can hold either a hard drive, an
optical drive or supports a weight saver option.

(8)

Optical drive eject button

Ejects the optical drive.

Right
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Left

Component
(1)

Description
Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)

USB 3.0 ports (2)

Connects optional USB devices.

(3)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(4)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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(5)

RJ-45 (network) jack

Connects a network cable.

(6)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(7)

eSATA/USB 2.0 combo port

Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional USB
device.

(8)

ExpressCard slot

Supports optional ExpressCards.

Chapter 2 External component identification

Display

Component

Description

(1)

Turns off the display and initiates Sleep if the display is closed
while the power is on.

Internal display switch

NOTE: The display switch is not visible from the outside of the
computer.
(2)

WLAN antennas (3)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3)

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(4)

Internal microphones (2)

Record sound.

(5)

Webcam light (select models only)

On: The webcam is in use.

(6)

Webcam (select models only)

Records video and captures still photographs.
To use the webcam, select Start > All Programs > HP >
HP Webcam.

(7)

ambient light sensor

The ambient light sensor automatically adjusts the display
brightness based on the lighting conditions in your environment.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display
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Rear

Component

Description

(1)

RJ-11 (modem) jack (select models only)

Connects a modem cable.

(2)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically
to cool internal components and prevent
overheating. It is normal for the internal fan to cycle
on and off during routine operation.

(3)
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Power connector
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Connects an AC adapter.

Bottom

Component

Description

(1)

Battery bay

Holds the battery.

(2)

SIM slot

Supports a wireless subscriber identity module (SIM). The
SIM slot is located inside the battery bay.

(3)

Battery release latch

Releases the battery from the battery bay.

(4)

Accessory battery connector

Connects an optional accessory battery.

(5)

Docking connector

Connects an optional docking device.

(6)

Bottom cover release latch

Releases or locks the bottom cover.

(7)

Vents (3)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(8)

Bluetooth compartment

Contains a Bluetooth device (select models only).

Bottom
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Component
(9)

Description
Speakers (2)

Produce sound.
NOTE: To use the SRS Premium Sound software, select
Start > All Programs > SRS Premium Sound.

(10)

Wireless and memory module
compartments and hard drive bay

Holds an HP Mobile Broadband Module, HP WLAN
Module, the memory modules, and the hard drive.
NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for
use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item

Component

Description

(1)

Product name

This is the product name affixed to the front of the
computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to each
product.

(3)

Part number/Product number (p/n)

This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Service tag

19

Computer major components

20

Chapter 3 Illustrated parts catalog

Item

Description

(1)

Display
Display panel, 43.9 cm (17.3 in), High Definition Plus (HD+) Anti-Glare (AG) WVA

652520-001

Display panel, 43.9 cm (17.3 in), FHD AG LED WVA

652521-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam
(not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna
and cables, and 2 WWAN antenna and cables)

652519-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

652518-001

NOTE:
(2)

Spare part number

See Display components on page 27 for more display component information and spare part numbers.

Keyboard (includes keyboard cable, pointing stick and pointing stick cable):
Without backlight, for use in Belgium

652553-A41

With backlight, for use in Belgium

652554-A41

Without backlight, for use in Brazil

652553-201

Without backlight, for use in Bulgaria

652553-261

With backlight, for use in Bulgaria

652554-261

Without backlight, for use in the Czech Republic and Slovakia

652553-A81

With backlight, for use in the Czech Republic and Slovakia

652554-A81

Without backlight, for use in Denmark

652553-081

With backlight, for use in Denmark

652554-081

Without backlight, for use in Finland and Sweden

652553-B71

With backlight, for use in Finland and Sweden

652554-B71

Without backlight, for use in France

652553-051

With backlight, for use in France

652554-051

Without backlight, for use in French Canada

652553-121

With backlight, for use in French Canada

652554-121

Without backlight, for use in Germany

652553-041

With backlight, for use in Germany

652554-041

Without backlight, for use in Greece

652553-DJ1

With backlight, for use in Greece

652554-DJ1

Without backlight, for use in Hungary

652553-211

With backlight, for use in Hungary

652554-211

Without backlight, for use in Iceland

652553-DD1

With backlight, for use in Iceland

652554-DD1

Without backlight, for use in Israel

652553-BB1

With backlight, for use in Israel

652554-BB1

Computer major components
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Item

22

Description

Spare part number

Without backlight, for use in Italy

652553-061

With backlight, for use in Italy

652554-061

Without backlight, for use in Japan

652553-291

Without backlight, for use in Latin America

652553-161

With backlight, for use in Latin America

652554-161

Without backlight, for international use

652553-B31

With backlight, for international use

652554-B31

Without backlight, for use in Northwest Africa

652553-DW1

With backlight, for use in Northwest Africa

652554-DW1

Without backlight, for use in Norway

652553-091

With backlight, for use in Norway

652554-091

Without backlight, for use in Portugal

652553-131

With backlight, for use in Portugal

652554-131

Without backlight, for use in Russia

652553-251

With backlight, for use in Russia

652554-251

Without backlight, for use in Saudi Arabia

652553-171

With backlight, for use in Saudi Arabia

652554-171

Without backlight, for use in Slovenia

652553-BA1

With backlight, for use in Slovenia

652554-BA1

Without backlight, for use in South Korea

652553-AD1

With backlight, for use in South Korea

652554-AD1

Without backlight, for use in Spain

652553-071

With backlight, for use in Spain

652554-071

Without backlight, for use in Switzerland

652553-BG1

With backlight, for use in Switzerland

652554-BG1

Without backlight, for use in Taiwan

652553-AB1

With backlight, for use in Taiwan

652554-AB1

Without backlight, for use in Thailand

652553-281

With backlight, for use in Thailand

652554-281

Without backlight, for use in Turkey

652553-141

With backlight, for use in Turkey

652554-141

Without backlight, for use in the United Kingdom and Singapore

652553-031

With backlight, for use in the United Kingdom and Singapore

652554-031

Without backlight, for use in the United States

652553-001
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Item

Description

Spare part number

With backlight, for use in the United States

652554-001

(3)

Top cover (includes TouchPad)

652536-001

(4)

Application button board

652516-001

(5)

TouchPad (included with top cover)

(6)

Fingerprint reader

655545-001

(7)

Power button board

652515-001

(8)

Fan/graphics board heat sink assembly (includes replacement thermal material):
For use with ATI graphics subsystem

652543-001

For use with NVIDIA graphics subsystem

652544-001

(9)

Audio/USB 2.0 board

652517-001

(10)

CRT board

655543-001

(11)

Fan

652541-001

(12)

Speaker assembly

652540-001

(13)

Processor heat sink

(14)

For use only with computer models equipped with quad-core processors

653629-001

For use only with computer models equipped with dual-core processors

652542-001

Processor (includes replacement thermal material):
2nd Generation Intel® Core™ processors (support Intel Turbo Boost Technology):
i7-2620M, 2.7 GHz (turbo up to 3.4 GHz) dual-core processor, 4 MB L3 cache, 4 threads,
35W

657844-001

i7-2630QM 2.0 GHz (turbo up to 2.9 GHz) quad-core processor, 6 MB L3 cache, 8 threads,
45W

657849-001

i7-2720QM, 2.2 GHz (turbo up to 3.3 GHz) quad-core processor, 6 MB L3 cache, 8
threads, 45W

657846-001

i7-2820QM, 2.3 GHz (turbo up to 3.4 GHz) quad-core processor, 8 MB L3 cache, 8
threads, 45W

657848-001

i7-2920XM, 2.5 GHz (turbo up to 3.5 GHz) quad-core extreme processor, 8 MB L3 cache,
8 threads, 55W

657850-001

2nd Generation Intel® Core™ i5 processors (support Intel Turbo Boost Technology):
i5-2520M, 2.5 GHz (turbo up to 3.2 GHz) dual-core processor, 3 MB L3 cache, 4 threads,
35W

657845-001

i5-2540M, 2.6 GHz (turbo up to 3.3 GHz) dual-core processor, 3 MB L3 cache, 4 threads,
35W

657847-001

(15)

USB 3.0 board

652514-001

(16)

Modem module 56K V.92 data/fax modem

628824-001

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 652545-001.
(17)

System board (includes replacement thermal material)
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Item

Description

Spare part number

For use in all countries and regions except the People's Republic of China and Russia:
●

For use with computer models equipped with Intel quad-core processors

652509-001

●

For use with computer models equipped with Intel dual-core processors

652508-001

For use only in the People's Republic of China and Russia:

(18)

(19)

●

For use with computer models equipped with Intel quad-core processors

655025-001

●

For use with computer models equipped with Intel dual-core processors

655024-001

Graphics board (includes replacement thermal material):
AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

647176-001

NVIDIA Quadro 3000M, N12E-Q1 2 GB dedicated GDDR5 video memory

647177-001

NVIDIA Quadro 4000M, N12E-Q3 2 GB dedicated GDDR5 video memory

647178-001

NVIDIA Quadro 5010M, N12E-Q5 4 GB dedicated GDDR5 video memory

647179-001

Security lock
NOTE: The security lock is included with the base enclosure assembly, spare part
number 652535-001.

(20)

Power connector cable
NOTE:

(21)

The power connector cable is included in the Cable Kit, spare part number 652545-001.

Network cable (includes RJ-45 jack)
NOTE:

The network cable is included in the Cable Kit, spare part number 652545-001.

(22)

Base enclosure (includes computer feet)

652535-001

(23)

RTC battery

651948-001

(24)

Memory modules (PC3-10600, 1333 MHz, shared):

(25)

2 GB

621565-001

4 GB

621569-001

8 GB

634091-001

Bluetooth module

537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.
(26)

Optical drive (includes bezel and bracket) supported in upgrade bay
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

652551-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

652550-001

DVD±RW SuperMulti Double-Layer Drive

652549-001

DVD-ROM Drive

652548-001

Also supported in upgrade bay:
500 GB, 7200 rpm hard drive
(27)
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652552-001

Item

(28)

Description

Spare part number

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

631954-001

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

572511-001

Atheros HB112AGN 802.11a/b/g/n 3x3 WiFi Adapter

630435-001

Mass storage device
Supports 7.0 mm (0.28 in), 9.5 mm (0.37 in) or 12.7 mm (0.5 in) hard drives and 6.35 cm (2.5 in) solid-state drive
for primary and secondary storage:
NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare part number
642774-001.
●

750 GB, SATA, 7200-rpm

633252-001

●

500 GB, SATA, 7200-rpm

634925-001

●

320 GB, SATA, 7200-rpm

641672-001

●

320 GB SATA SED (Self-Encrypting Drive), 7200-rpm

626978-001

Solid-state drive (includes bracket and screws)

(29)

●

256 GB solid-state drive

655027-001

●

128 GB solid-state drive

655026-001

WWAN module:
HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

HP hs2340 HSPA+ Mobile Broadband Module

632155-001

(30)

Smart Card reader

655544-001

(31)

Battery:
8-cell, Li-ion, 2.8 Ah (75 WHr)

632425-001

8-cell, Li-ion, 2.8 Ah (83 WHr)

632427-001

(32)

Smart Card reader cover

652546-001

(33)

Service access cover

652537-001

Computer major components

25

Cable Kit

Item

26

Description

Spare part number

Cable Kit

652545-001

(1)

Power connector cable

(2)

Network cable (includes RJ-45 jack)

(3)

Modem module cable (includes RJ-11 jack)

(4)

Bluetooth module cable
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Display components

Item

Description

(1)

Display bezel

(2)

(3)

Spare part number

For use only with computer models with a webcam

652522-001

For use only with computer models without a webcam

652523-001

Display
Display panel, 43.9 cm (17.3 in), FHD AG WVA

652521-001

Display panel, 43.9 cm (17.3 in), HD+ AG WVA

652520-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

652518-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with
webcam (not available with HP Mobile Broadband) (includes display panel cable, 3 WLAN
antenna and cables, and 2 WWAN antenna and cables)

652519-001

Display Hinge Kit (includes left and right hinges and brackets)

652528-001

Display components
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Item

Description

Spare part number

(4)

Display hinge covers

652529-001

(5)

Cable routing tray

(6)

WWAN antenna and cables (included in the Antenna Kit, spare part number
652530-001)

(7)

Webcam module with microphone

(8)

WLAN antenna and cables (included in the Antenna Kit, spare part number 652530-001)

(9)

Webcam cable

652527-001

(10)

Display panel cable (includes webcam module cable and ambient light sensor board
cable)

652525-001

(11)

Display latch (2)

(12)

Display enclosure

652524-001

Ambient light sensor board (not illustrated)

655028-001

Display Rubber Kit (not illustrated, includes 2 bezel rubber bumpers and 8 rubber screw
covers

652532-001

Display Miscellaneous Kit (not illustrated)

652533-001

Display Screw Kit (not illustrated)

652531-001

Antenna Kit (includes WLAN and WWAN antennas) (not illustrated)

652530-001

Display Panel Support Kit (includes display back cover, WWAN and WLAN antenna
cables, and webcam cable) (not illustrated)

658265-001

Microphone (not illustrated)

655312-001

CRT board (not illustrated)

655543-001
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642795-001

Mass storage devices

Item

Description

(1)

7.0 mm (0.28 in), 9.5 mm (0.37 in), or 12.7 mm (0.5 in) hard drive:
NOTE:

(2)

(4)

Spare part number

The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 642774-001.

●

750 GB, 7200-rpm

633252-001

●

500 GB, 7200-rpm

634925-001

●

320 GB, 7200-rpm

641672-001

●

320 GB, 7200-rpm SATA SED (Self-Encrypting Drive)

626978-001

6.35 cm (2.50 in) solid-state drive (includes bracket):
256 GB solid-state drive

655027-001

128 GB solid-state drive

655026-001

Optical drive (includes bezel and bracket)
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

652551-001

DVD±RW SuperMulti Double-Layer Drive

652549-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

652550-001

DVD-ROM Drive

652548-001

(4)

Optical drive bracket (included with optical drive)

(5)

Hard drive bracket (included only with solid-state drives)

Mass storage devices
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Plastics Kit

Item

30

Description

Spare part number

Plastics Kit:

655546-001

(1)

Optical drive compartment cover

(2)

RJ-11 (modem) jack cover

(3)

SD Card cover

(4)

ExpressCard slot cover
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Miscellaneous parts
Description

Spare part number

AC Adapter
230W RC/V Slim AC Smart Adapter

611533-001

200W RC/V Slim AC Smart Adapter

645154-001

Power cord (3 conductor, black,1.83 m):
For use in Argentina

491683-D01

For use in Australia

491683-011

For use in Brazil

491683-202

For use in Denmark

491683-081

For use in Europe, the Middle East, and Africa

491683-021

For use in India

491683-D61

For use in Israel

491683-BB1

For use in Italy

491683-061

For use in Japan

491683-291

For use in North America

491683-001

For use in the People's Republic of China

491683-AA1

For use in South Africa

491683-AR1

For use in South Korea

491683-AD1

For use in Switzerland

491683-111

For use in Taiwan

491683-AB1

For use in Thailand

491683-201

For use in the United Kingdom and Singapore

491683-031

Hard Drive Hardware Kit (includes hard drive bracket and screws)

642774-001

Hard drive upgrade bay

655547-001

Screw Kit

652539-001

ExpressCard socket

652547-001

Miscellaneous parts
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Sequential part number listing
Spare part
number

Description

491683-001

Power cord for use in North America (3 conductor, black,1.83 m)

491683-011

Power cord for use in Australia (3 conductor, black,1.83 m)

491683-021

Power cord for use in Europe, the Middle East, and Africa (3 conductor, black,1.83 m)

491683-031

Power cord for use in Singapore and the United Kingdom (3 conductor, black,1.83 m)

491683-061

Power cord for use in Italy (3 conductor, black,1.83 m)

491683-081

Power cord for use in Denmark (3 conductor, black,1.83 m)

491683-111

Power cord for use in Switzerland (3 conductor, black,1.83 m)

491683-201

Power cord for use in Thailand (3 conductor, black,1.83 m)

491683-202

Power cord for use in Brazil (3 conductor, black,1.83 m)

491683-291

Power cord for use in Japan (3 conductor, black,1.83 m)

491683-AA1

Power cord for use in the People's Republic of China (3 conductor, black,1.83 m)

491683-AB1

Power cord for use in Taiwan (3 conductor, black,1.83 m)

491683-AD1

Power cord for use in South Korea (3 conductor, black,1.83 m)

491683-AR1

Power cord for use in South Africa (3 conductor, black,1.83 m)

491683-BB1

Power cord for use in Israel (3 conductor, black,1.83 m)

491683-D01

Power cord for use in Argentina (3 conductor, black,1.83 m)

491683-D61

Power cord for use in India (3 conductor, black,1.83 m)

537921-001

Bluetooth module, HP Integrated Module with Bluetooth 2.1+EDR Wireless Technology
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 652545-001.
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572511-001

WLAN, Intel Centrino Ultimate-N 6300 802.11 a/b/g/n

611533-001

AC adapter, 230 W RC/V Slim AC Smart adapter

621565-001

Memory module, 2 GB (PC3-10600, 1333 MHz)

621569-001

Memory module, 4 GB (PC3-10600, 1333 MHz)

626978-001

Hard drive, 320 GB, 7200-rpm SATA SED (Self-Encrypting Drive)

628824-001

Modem, 56K V.92 data/fax modem

630435-001

WLAN, Atheros HB112AGN 802.11a/b/g/n WiFi Adapter

631954-001

WLAN, Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n

632155-001

WWAN, HP hs2340 HSPA+ Mobile Broadband Module

632425-001

Battery, 8-cell, Li-ion, 2.8 Ah (75 WHr)

632427-001

Battery, 8-cell, Li-ion, 2.8 Ah (83 WHr)

633252-001

Hard drive, 750 GB, 7200-rpm SATA

634091-001

Memory module, 8 GB (PC3-10600, 1333 MHz)
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Spare part
number

Description

634400-001

WWAN, HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001

Hard drive, 500 GB, 7200-rpm SATA

641672-001

Hard drive, 320 GB, 7200-rpm SATA

642774-001

Hard Drive Hardware Kit (includes hard drive bracket and screws)

642795-001

Webcam module with microphone

645154-001

AC adapter, 200 W RC/V Slim AC Smart Adapter

647176-001

Graphics board, AMD FirePro M5950 XT-GL 1 GB GDDR5 (DP 1.2 and Eyefinity Plus support)

647177-001

Graphics board, NVIDIA Quadro 3000M, N12E-Q1 2 GB dedicated GDDR5 video memory

647178-001

Graphics board, NVIDIA Quadro 4000M, N12E-Q3 2 GB dedicated GDDR5 video memory

647179-001

Graphics board, NVIDIA Quadro 5010M, N12E-Q5 4 GB dedicated GDDR5 video memory

651948-001

RTC battery

652508-001

System board for use with computer models equipped with Intel dual-core processors in all countries and
regions except the People's Republic of China and Russia (includes replacement thermal material)

652509-001

System board for use with computer models equipped with Intel quad-core processors in all countries and
regions except the People's Republic of China and Russia (includes replacement thermal material)

652514-001

USB 3.0 board (includes cable)

652515-001

Power button board

652516-001

Application button board

652517-001

Audio/USB 2.0 board

652518-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam (not
available with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and cables, and 2
WWAN antenna and cables)

652519-001

Display assembly, 43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not available
with HP Mobile Broadband) (includes display panel cable, 3 WLAN antenna and cables, and 2 WWAN
antenna and cables)

652520-001

Display panel, 43.9 cm (17.3 in), HD+ AG WVA

652521-001

Display panel, 43.9 cm (17.3 in), FHD AG WVA

652522-001

Display bezel, for use only with computer models with a webcam

652523-001

Display bezel, for use only with computer models without a webcam

652524-001

Top cover (includes TouchPad)

652525-001

Display panel cable (includes webcam module cable and ambient light sensor board cable)

652527-001

Webcam cable

652528-001

Display Hinge Kit (includes left and right hinges and brackets)

652529-001

Display hinge covers

652530-001

Antenna Kit (includes WLAN antenna and cables and WWAN antenna and cables)

652531-001

Display Screw Kit

Sequential part number listing
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34

Spare part
number

Description

652532-001

Display Rubber Kit (includes 2 bezel rubber bumpers and 8 rubber screw covers)

652533-001

Display Miscellaneous Kit

652535-001

Base enclosure (includes computer feet)

652536-001

Top cover

652537-001

Service access cover

652539-001

Screw Kit

652540-001

Speaker assembly

652541-001

Fan

652542-001

Processor heat sink for use only with computer models equipped with dual-core processors (includes
replacement thermal material)

652543-001

Fan/graphics board heat sink assembly for use only with computer models equipped with ATI graphics
subsystems (includes replacement thermal material)

652544-001

Fan/graphics board heat sink assembly, for use only with computer models equipped with NVIDIA Quadro
graphics subsystems (includes replacement thermal material)

652545-001

Cable Kit (includes DC-jack cable, RJ-45 cable, modem module cable, Bluetooth cable)

652546-001

Smart Card cover

652547-001

ExpressCard socket

652548-001

DVD-ROM Drive

652549-001

Optical drive, DVD±RW SuperMulti Double-Layer Drive

652550-001

Optical drive, Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

652551-001

Optical drive, Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

652552-001

Upgrade bay hard drive, 500 GB, 7200 rpm hard drive

652553-001

Keyboard without backlight for use in the United States (includes keyboard cable, pointing stick and pointing
stick cable)

652553-031

Keyboard without backlight for use in Singapore and the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)

652553-041

Keyboard without backlight for use in Germany (includes keyboard cable, pointing stick and pointing stick
cable)

652553-051

Keyboard without backlight for use in France (includes keyboard cable, pointing stick and pointing stick
cable)

652553-061

Keyboard without backlight for use in Italy (includes keyboard cable, pointing stick and pointing stick cable)

652553-071

Keyboard without backlight for use in Spain (includes keyboard cable, pointing stick and pointing stick
cable)

652553-081

Keyboard without backlight for use in Denmark (includes keyboard cable, pointing stick and pointing stick
cable)

652553-091

Keyboard without backlight for use in Norway (includes keyboard cable, pointing stick and pointing stick
cable)

652553-121

Keyboard without backlight for use in French Canada (includes keyboard cable, pointing stick and pointing
stick cable)
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Spare part
number

Description

652553-131

Keyboard without backlight for use in Portugal (includes keyboard cable, pointing stick and pointing stick
cable)

652553-141

Keyboard without backlight for use in Turkey (includes keyboard cable, pointing stick and pointing stick
cable)

652553-161

Keyboard without backlight for use in Latin America (includes keyboard cable, pointing stick and pointing
stick cable)

652553-171

Keyboard without backlight for use in Saudi Arabia (includes keyboard cable, pointing stick and pointing
stick cable)

652553-201

Keyboard without backlight for use in Brazil (includes keyboard cable, pointing stick and pointing stick
cable)

652553-211

Keyboard without backlight for use in Hungary (includes keyboard cable, pointing stick and pointing stick
cable)

652553-251

Keyboard without backlight for use in Russia (includes keyboard cable, pointing stick and pointing stick
cable)

652553-261

Keyboard without backlight for use in Bulgaria (includes keyboard cable, pointing stick and pointing stick
cable)

652553-281

Keyboard without backlight for use in Thailand (includes keyboard cable, pointing stick and pointing stick
cable)

652553-291

Keyboard without backlight for use in Japan (includes keyboard cable, pointing stick and pointing stick
cable)

652553-A41

Keyboard without backlight for use in Belgium (includes keyboard cable, pointing stick and pointing stick
cable)

652553-A81

Keyboard without backlight for use in the Czech Republic and Slovakia (includes keyboard cable, pointing
stick and pointing stick cable)

652553-AB1

Keyboard without backlight for use in Taiwan (includes keyboard cable, pointing stick and pointing stick
cable)

652553-AD1

Keyboard without backlight for use in South Korea (includes keyboard cable, pointing stick and pointing
stick cable)

652553-B31

Keyboard without backlight for international use (includes keyboard cable, pointing stick and pointing stick
cable)

652553-B71

Keyboard without backlight for use in Finland and Sweden (includes keyboard cable, pointing stick and
pointing stick cable)

652553-BA1

Keyboard without backlight for use in Slovenia (includes keyboard cable, pointing stick and pointing stick
cable)

652553-BB1

Keyboard without backlight for use in Israel (includes keyboard cable, pointing stick and pointing stick
cable)

652553-BG1

Keyboard without backlight for use in Switzerland (includes keyboard cable, pointing stick and pointing stick
cable)

652553-DD1

Keyboard without backlight for use in Iceland (includes keyboard cable, pointing stick and pointing stick
cable)

652553-DJ1

Keyboard without backlight for use in Greece (includes keyboard cable, pointing stick and pointing stick
cable)

652553-DW1

Keyboard without backlight for use in Northwest Africa (includes keyboard cable, pointing stick and pointing
stick cable)
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Spare part
number

Description

652554-001

Keyboard with backlight for use in the United States (includes keyboard cable, pointing stick and pointing
stick cable)

652554-031

Keyboard with backlight for use in Singapore and the United Kingdom (includes keyboard cable, pointing
stick and pointing stick cable)

652554-041

Keyboard with backlight for use in Germany (includes keyboard cable, pointing stick and pointing stick
cable)

652554-051

Keyboard with backlight for use in France (includes keyboard cable, pointing stick and pointing stick cable)

652554-061

Keyboard with backlight for use in Italy (includes keyboard cable, pointing stick and pointing stick cable)

652554-071

Keyboard with backlight for use in Spain (includes keyboard cable, pointing stick and pointing stick cable)

652554-081

Keyboard with backlight for use in Denmark (includes keyboard cable, pointing stick and pointing stick
cable)

652554-091

Keyboard with backlight for use in Norway (includes keyboard cable, pointing stick and pointing stick cable)

652554-121

Keyboard with backlight for use in French Canada (includes keyboard cable, pointing stick and pointing
stick cable)

652554-131

Keyboard with backlight for use in Portugal (includes keyboard cable, pointing stick and pointing stick cable)

652554-141

Keyboard with backlight for use in Turkey (includes keyboard cable, pointing stick and pointing stick cable)

652554-161

Keyboard with backlight for use in Latin America (includes keyboard cable, pointing stick and pointing stick
cable)

652554-171

Keyboard with backlight for use in Saudi Arabia (includes keyboard cable, pointing stick and pointing stick
cable)

652554-211

Keyboard with backlight for use in Hungary (includes keyboard cable, pointing stick and pointing stick cable)

652554-251

Keyboard with backlight for use in Russia (includes keyboard cable, pointing stick and pointing stick cable)

652554-261

Keyboard with backlight for use in Bulgaria (includes keyboard cable, pointing stick and pointing stick cable)

652554-281

Keyboard with backlight for use in Thailand (includes keyboard cable, pointing stick and pointing stick
cable)

652554-A41

Keyboard with backlight for use in Belgium (includes keyboard cable, pointing stick and pointing stick cable)

652554-A81

Keyboard with backlight for use in the Czech Republic and Slovakia (includes keyboard cable, pointing stick
and pointing stick cable)

652554-AB1

Keyboard with backlight for use in Tawain (includes keyboard cable, pointing stick and pointing stick cable)

652554-AD1

Keyboard with backlight for use in South Korea (includes keyboard cable, pointing stick and pointing stick
cable)

652554-B31

Keyboard with backlight for international use (includes keyboard cable, pointing stick and pointing stick
cable)

652554-B71

Keyboard with backlight for use in Finland and Sweden (includes keyboard cable, pointing stick and
pointing stick cable)

652254-BA1

Keyboard with backlight for use in Slovenia (includes keyboard cable, pointing stick and pointing stick
cable)

652554-BB1

Keyboard with backlight for use in Israel (includes keyboard cable, pointing stick and pointing stick cable)

652554-BG1

Keyboard with backlight for use in Switzerland (includes keyboard cable, pointing stick and pointing stick
cable)
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Spare part
number

Description

652554-DD1

Keyboard with backlight for use in Iceland (includes keyboard cable, pointing stick and pointing stick cable)

652554-DJ1

Keyboard with backlight for use in Greece (includes keyboard cable, pointing stick and pointing stick cable)

652554-DW1

Keyboard with backlight for use in Northwest Africa (includes keyboard cable, pointing stick and pointing
stick cable)

653629-001

Processor heat sink for use only with computer models equipped with quad-core processors (includes
replacement thermal material)

655024-001

System board for use with computer models equipped with Intel dual-core processors only in the People's
Republic of China and Russia (includes replacement thermal material)

655025-001

System board for use with computer models equipped with Intel quad-core processors only in the People's
Republic of China and Russia (includes replacement thermal material)

655026-001

128 GB solid-state drive (includes bracket)

655027-001

256 GB solid-state drive (includes bracket)

655028-001

Ambient light sensor board

655312-001

Microphone

655543-001

CRT board

655544-001

Smart Card reader

655545-001

Fingerprint reader

655546-001

Plastics Kit (includes optical drive compartment cover, RJ-11 (modem) jack cover, SD Card cover, and
Express Card slot cover)

655547-001

Hard drive upgrade bay

657844-001

Processor, 2nd Generation Intel® Core™ i7-2620M dual-core processor, 2.7 GHz (turbo up to 3.4 GHz), 4
MB L3 cache, 4 threads, 35W (supports Intel Turbo Boost Technology) (includes thermal material)

657845-001

Processor, 2nd Generation Intel® Core™ i5-2520M dual-core processor, 2.5 GHz (turbo up to 3.2 GHz), 3
MB L3 cache, 4 threads, 35W (supports Intel Turbo Boost Technology) (includes thermal material)

657846-001

Processor, 2nd Generation Intel® Core™ i7-2720QM quad-core processor, 2.2 GHz (turbo up to 3.3 GHz),
6 MB L3 cache, 8 threads, 45W (supports Intel Turbo Boost Technology) (includes thermal material)

657847-001

Processor, 2nd Generation Intel® Core™ i5-2540M dual-core processor, 2.6 GHz (turbo up to 3.3 GHz), 3
MB L3 cache, 4 threads, 35W (supports Intel Turbo Boost Technology) (includes thermal material)

657848-001

Processor, 2nd Generation Intel® Core™ i7-2820QM quad-core processor, 2.3 GHz (turbo up to 3.4 GHz),
8 MB L3 cache, 8 threads, 45W (supports Intel Turbo Boost Technology) (includes thermal material)

657849-001

Processor, 2nd Generation Intel® Core™ i7-2630QM quad-core processor, 2.0 GHz (turbo up to 2.9 GHz),
6-MB L3 cache, 8 threads, 45W (supports Intel Turbo Boost Technology) (includes thermal material)

657850-001

Processor, 2nd Generation Intel® Core™ i7-2920XM quad-core extreme, 2.5 GHz (turbo up to 2.9 GHz), 8MB L3 cache, 8 threads, 55W (supports Intel Turbo Boost Technology) (includes thermal material)

658265-001

Display Panel Support Kit (includes display enclosure, WLAN antenna cables, WWAN antenna cables, and
webcam cable)
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

●

5.0 mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and and pointing stick connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits
provide some protection, but in many cases, ESD contains enough power to alter device parameters
or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and and pointing stick can work
perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in
the internal layers, reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you area ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.
Avoid touching pins, leads, and pointing stick circuitry. Handle electronic components as little as
possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick
containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and pointing stick conveyors made of antistatic belts and roller bushings. Be
sure that mechanized equipment used for moving materials is wired to ground and that proper
materials are selected to avoid static charging. When grounding is not possible, use an ionizer to
dissipate electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of non conductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid and pointing stick contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground and pointing stick cords.
To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats
with banana-plug connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground and pointing stick cords of one megohm
resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Non conductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 98 screws and screw locks that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw and screw lock size and location during
removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag.

Item

Component

Description

(1)

Product name

This is the product name affixed to the front of the
computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to each
product.

(3)

Part number/Product number (p/n)

This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Component replacement procedures
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the base enclosure
spare part kit, spare part number 652535-001. There are 7 rubber feet that attach to the base
enclosure in the locations illustrated below.
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Battery
Description

Spare part number

8-cell, Li-ion 2.8 Ah (75 WHr)

632425-001

8-cell, Li-ion 2.8 Ah (83 WHr)

632427-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Position the computer upside down on a flat surface, with the front toward you.

2.

Slide the battery release latch to the left (1) to release the battery.

3.

Pivot the battery (2) upward and lift it out of the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.

SIM
Before removing the SIM, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

Remove the SIM:
1.

Press in on the SIM (1) to release it from the SIM slot.

2.

Remove the SIM (2) from the SIM slot.

Install the SIM by inserting it into the SIM slot until you hear a click.

Service access cover
Description

Spare part number

Service access cover

652537-001

Before removing the service access cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

Remove the service access cover:
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1.

Position the computer upside down on a flat surface, with the front toward you.

2.

Slide the service access cover release latch to the right (1) to release the service access cover.
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3.

Slide the service access cover toward the front of the computer (2) and then remove the cover
(3).

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 652545-001. See Bluetooth
module cable on page 104 for information on replacing the Bluetooth module cable.
Description

Spare part number

Bluetooth module

537921-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove the Bluetooth module:
1.

Gently pry the Bluetooth module away from the retaining clips in the base enclosure (1).

2.

Disconnect the Bluetooth module from the Bluetooth cable (2).
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3.

Remove the Bluetooth module (3).

Reverse this procedure to install the Bluetooth module.

WLAN module
Description

Spare part number

Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module

631954-001

Intel Centrino Ultimate-N 6300, 802.11a/b/g/n WLAN module

572511-001

Atheros HB112AGN 802.11a/b/g/n 3x3 WiFi Adapter

630435-001

CAUTION: The WLAN module and the WWAN module are not interchangeable.
To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).
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Remove the WLAN module:
1.

Position the computer with the front toward you.

2.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cables are numbered and connect from left to right on the WLAN
module.

3.

Remove the two Phillips M2.0×2.0 screws (2) that secure the WLAN module to the system
board. (The WLAN module tilts up.)

4.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion of the
WLAN module into the WLAN module slot.

Reverse this procedure to install the WLAN module.

WWAN module
Description

Spare part number

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

HP hs2340 HSPA+ Mobile Broadband Module

632155-001

CAUTION: The WWAN module and the WLAN module are not interchangeable.
To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in
your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.
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Before removing the WWAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove the WWAN module:
1.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2.

Remove the two Phillips M2.0×2.0 screws (2) that secure the WWAN module to the system
board. (The WWAN module tilts up.)

3.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.
NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion of the
WWAN module into the WWAN module slot.

Reverse this procedure to install the WWAN module.

RTC battery
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Description

Spare part number

RTC battery

651948-001
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Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove the RTC battery:
▲

Disconnect the RTC battery cable (1) from the system board and remove the RTC battery (2).

Reverse this procedure to install the RTC battery.

Smart Card reader
Description

Spare part number

Smart Card reader

655544-001

Smart Card reader cover

652546-001

Before removing the Smart Card reader, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Position the computer with the front toward you.

7.

Loosen the captive screw (1) on the Smart Card reader cover.

8.

Disconnect the zero insertion force (ZIF) connector (2) and remove the cable (3) from the
system board.
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9.

Lift the rear edge (1) of the Smart Card reader cover and remove the cover (2).

10. Remove the Phillips M3.0x2.5 screw (1) that secures the Smart Card reader to the Smart Card
reader cover.
11. Slide the Smart Card reader (2) back toward the hinges on the Smart Card reader cover.
12. Remove the Smart Card reader (3) from the Smart Card reader cover.

Reverse this procedure to reassemble and install the Smart Card reader.
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Primary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.
Description

Spare part number

750 GB, 7200-rpm SATA hard drive

633252-001

500 GB, 7200-rpm SATA hard drive

634925-001

320 GB, 7200-rpm SATA hard drive

641672-001

320 GB, 7200-rpm SATA SED hard drive

626978-001

256 GB solid-state drive (includes bracket and screws)

655027-001

128 GB solid-state drive (includes bracket and screws)

655026-001

Before removing the primary hard drive, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Position the computer with the front toward you.

7.

Loosen the captive screw on the Smart Card reader cover (1).

8.

Loosen the two captive screws on the hard drive (2).
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9.

Lift the Smart Card reader access cover to the upright position (3).

10. Loosen the Phillips M2.5x10.5 captive screw (1) that secures the hard drive to the computer.
11. Grasp the tab on the hard drive and slide the hard drive (2) to the right.
12. Lift the left side of the hard drive (3) and remove the hard drive (4) at an angle from the hard
drive bay.

13. If it is necessary to replace the hard drive bracket, follow these steps:
a.

Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.
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b.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.

Secondary hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.
Description

Spare part number

750 GB, 7200-rpm SATA hard drive

633252-001

500 GB, 7200-rpm SATA hard drive

634925-001

320 GB, 7200-rpm SATA hard drive

641672-001

320 GB, 7200-rpm SATA SED hard drive

626978-001

256 GB solid-state drive (includes bracket and screws)

655027-001

128 GB solid-state drive (includes bracket and screws)

655026-001

Before removing the secondary hard drive, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).
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Remove the secondary hard drive:
1.

Position the computer with the front toward you.

2.

Loosen the two Phillips M2.5x10.5 captive screws (1) that secure the hard drive to the computer.

3.

Loosen the Phillips M2.5x10.5 captive screw (2) that secures the hard drive to the computer.

4.

Grasp the tab and slide the hard drive (3) to the right.

5.

Lift the hard drive up (4) to remove it from the hard drive bay.

6.

If it is necessary to replace the hard drive bracket, follow these steps:
a.

Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard
drive.
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b.

Lift the bracket (2) straight up to remove it.

Reverse this procedure to reassemble and install the primary hard drive.

Optical drive
Description

Spare part number

Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive

652551-001

DVD±RW SuperMulti Double-Layer Drive

652549-001

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive

652550-001

DVD-ROM Drive

652548-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove the optical drive:
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1.

Position the computer with the front toward you.

2.

Loosen the Phillips captive screw (1) that secures the optical drive to the computer.
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3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4.

Remove the optical drive (3).

5.

If it is necessary to replace the optical drive bracket:

6.

a.

Position the optical drive with the rear toward you.

b.

Remove the three Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.

c.

Remove the optical drive bracket (2).

If it is necessary to remove the optical drive bezel:
a.

Insert the end of a paper clip into the release access hole (1) in the optical drive bezel.
Press in gently until the tray is released.
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b.

Firmly pull outward on the open tray (2) until the optical drive slides out.

c.

Firmly pull outward on the bezel to remove the bezel from the optical drive tray.

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay hard drive
NOTE: The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number
642774-001.

60

Description

Spare part number

7.0 mm, 9.5 mm, or 12.7 mm 500 GB hard drive, 7200 rpm

652552-001
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Before removing the upgrade bay hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove the upgrade bay hard drive:
1.

Position the computer with the front toward you.

2.

Remove the four Phillips PM3.0×3.0 screws (1) that secure the upgrade bay hard drive carrier to
the computer.

3.

Loosen the Phillips captive screw (1) that secures the hard drive to the computer.

4.

Insert a flat-bladed screwdriver or similar tool into the upgrade bay hard drive tab access (2) and
press the tab to the left to release the upgrade bay hard drive from the computer.
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5.

Remove the upgrade bay hard drive (3).

Reverse this procedure to reassemble and install the upgrade bay hard drive and upgrade bay hard
drive carrier.

Primary memory module
NOTE:

Primary memory is installed under the keyboard.

A computer having a system board with spare part number 652508-001 or 655024-001 has two
memory slots (primary memory slots). When adding or replacing memory modules, slot 1 must be
populated before slot 2 is populated.
A computer having a system board with spare part number 652509-001 or 655025-001 has four
memory slots (expansion memory slots) (on the bottom of the computer) and the primary memory
slots (under the keyboard). Slot 2 cannot be populated if slot 1 is not populated.
Description

Spare part number

8192 MB memory module (PC3-10600, 1333 MHz, DDR3)

634091-001

4096 MB memory module (PC3-10600, 1333 MHz, DDR3)

621569-001

2048 MB memory module (PC3-10600, 1333 MHz, DDR3)

621565-001

NOTE: A memory module must be installed in the bottom primary memory module slot before a
memory module is installed in the top primary memory module slot.
Before removing a primary memory module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46)

6.

Remove the hard drive (see Primary hard drive on page 54).

7.

Remove the keyboard (see Keyboard on page 65).

Remove the primary memory module:
1.

Spread the retaining tabs (1) on each side of the primary memory module slot to release the
primary memory module. (The edge of the module opposite the slot rises away from
the computer.)

2.

Remove the primary memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
primary memory module slots.

Reverse this procedure to install a primary memory module.

Expansion memory module
NOTE:

Expansion memory slots are located in a compartment on the bottom of the computer.

A computer having a system board with spare part number 652508-001 or 655024-001 has two
memory slots, which are called primary memory slots in this MSG. When you add or replace memory
modules, slot 1 must be populated before slot 2 is populated.
A computer having a system board with spare part number 652509-001 or 655025-001 has four
memory slots. On these computers, in both the expansion memory slots (on the bottom of the
computer) and the primary memory slots (under the keyboard), slot 1 must be populated before slot 2
is populated.
Description

Spare part number

8192 MB memory module (PC3-10600, 1333 MHz, DDR3)

634091-001

4096 MB memory module (PC3-10600, 1333 MHz, DDR3)

621569-001

2048 MB memory module (PC3-10600, 1333 MHz, DDR3)

621565-001
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NOTE: A memory module must be installed in the right expansion memory module slot before a
memory module is installed in the left expansion memory module slot.
Before removing an expansion memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Remove an expansion memory module:
1.

Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
expansion memory module. (The edge of the module opposite the slot rises away from
the computer.)

2.

Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
expansion memory module slots.

Reverse this procedure to install an expansion memory module.
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Keyboard
For use in:

Spare part number

For use in:

Spare part number

Keyboard with backlight (includes keyboard cable, pointing stick and pointing stick cable):
Belgium

652554-A41

Northwest Africa

652554-DW1

Bulgaria

652554-261

Norway

652554-091

Czech Republic and Slovakia

652554-A81

Portugal

652554-131

Denmark

652554-081

Russia

652554-251

Finland and Sweden

652554-B71

Saudi Arabia

652554-171

France

652554-051

Slovenia

652554-BA1

French Canada

652554-121

South Korea

652554-AD1

Germany

652554-041

Spain

652554-071

Greece

652554-DJ1

Switzerland

652554-BG1

Hungary

652554-211

Taiwan

652554-AB1

Iceland

652554-DD1

Thailand

652554-281

Internationally

652554-B31

Turkey

652554-141

Israel

652554-BB1

The United Kingdom and Singapore

652554-031

Italy

652554-061

The United States

652554-001

Latin America

652554-161

Keyboard without backlight (includes keyboard cable, pointing stick and pointing stick cable):
Belgium

652553-A41

Northwest Africa

652553-DW1

Brazil

652553-201

Norway

652553-091

Bulgaria

652553-261

Portugal

652553-131

Czech Republic and Slovakia

652553-A81

Russia

652553-251

Denmark

652553-081

Saudi Arabia

652553-171

Finland and Sweden

652553-B71

Slovenia

652553-BA1

France

652553-051

South Korea

652553-AD1

French Canada

652553-121

Spain

652553-071

Germany

652553-041

Switzerland

652553-BG1

Greece

652553-DJ1

Taiwan

652553-AB1

Hungary

652553-211

Thailand

652553-281

Iceland

652553-DD1

Turkey

652553-141

Internationally

652553-B31

The United Kingdom and Singapore

652553-031

Israel

652553-BB1

The United States

652553-001

Italy

652553-061

Japan

652553-291
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Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

Remove the keyboard:
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1.

Position the computer with the front toward you.

2.

Loosen the three Phillips captive screws (1) that secure the keyboard to the computer.

3.

Position the computer on its side with the display open at a 90 degree angle.
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4.

Insert a small tool at an angle through the hole in the optical drive bay at an angle to push out
the top edge of the keyboard.

5.

Turn the computer right-side up, with the front toward you.

6.

Open the display as far as it will open.

7.

Lift the rear edge (1) of the keyboard until it rests at an angle.

8.

Slide the keyboard back toward the display (2).
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9.

Turn the keyboard over to rest on the palm rest.

10. Release the keyboard ZIF connector (1) and lift the keyboard cable (2) to release it.
11. Release the pointing stick ZIF connector (3) and lift the cable (4) to release it.

Reverse this procedure to install the keyboard.

Fan/graphics board heat sink assembly
NOTE:
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The fan/graphics board heat sink assemblies include replacement thermal material.

Description

Spare part number

For use only with computer models equipped with ATI graphics subsystems

652543-001

For use only with computer models equipped with NVIDIA graphics subsystems

652544-001
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NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a
temperature sensor and is designed to turn on automatically when high temperature conditions exist.
These conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.
Before removing the graphics board heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81)

9.

Remove the display assembly (see Display assembly on page 85).

Remove the fan/graphics board heat sink assembly:
1.

Disconnect the fan cable (1) from the system board.

2.

Following the sequence stamped into the graphics board heat sink, loosen the six Phillips
captive screws (2) that secure the graphics board heat sink/fan assembly to the system board.
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3.

Lift the heat sink/fan assembly (3) straight up to remove it.
NOTE: Due to the adhesive quality of the thermal material located between the fan/graphics
board heat sink assembly and graphics board components, it may be necessary to move the
graphics board heat sink from side to side to detach it from the system board.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics
board heat sink and the graphics board each time the graphics board heat sink is removed:
Thermal paste is used on the largest component (1) on the graphics board and the graphics
board heat sink section (2) that services it. Thermal pads are used on the other graphics board
components (3) and the graphics board heat sink sections (4) that service them.

Reverse this procedure to install the fan/graphics board heat sink assembly.
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Fan
Description

Spare part number

Fan

652541-001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 68).

Remove the fan from the fan/graphics board heat sink assembly:
1.

Remove the three Phillips PM2.0×3.0 screws (1) that secure the fan to the fan/graphics board
heat sink assembly.

2.

Remove the fan (2).
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Reverse this procedure to install the fan into the fan/graphics board heat sink assembly.

Graphics board
NOTE:

The graphics board spare part kit includes replacement thermal material.

Description

Spare part number

AMD FirePro M5950 XT-GL 1GB GDDR5 (DP 1.2 and Eyefinity Plus support)

647176-001

NVIDIA Quadro 5010M, N12E-Q5 4 GB dedicated GDDR5 video memory

647179-001

NVIDIA Quadro 4000M, N12E-Q3 2 GB dedicated GDDR5 video memory

647178-001

NVIDIA Quadro 3000M, N12E-Q1 2 GB dedicated GDDR5 video memory

647177-001

Before removing the graphics board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45),

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 68).

Remove the graphics board:
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1.

Remove the two Phillips M2.5×3.0 screws (1) that secure the graphics board to the system
board.

2.

Lift the right edge of the graphics board (2) until it rests at an angle.
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3.

Remove the graphics board (3) out to the right.

Reverse this procedure to install the graphics board.

Processor heat sink
Description

Spare part number

For use only with computer models equipped with quad-core processors

653629-001

For use only with computer models equipped with dual-core processors

652542-001

Before removing the processor heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45)

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 68).
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Remove the processor heat sink:
1.

Following the sequence stamped into the processor heat sink, loosen the four Phillips captive
screws (1) that secure the processor heat sink to the system board.
NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and the processor, it may be necessary to move the processor heat sink from side to side to
detach it from the system board.
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2.

Lift the processor heat sink (2) up and to the right at an angle and remove it from the base
enclosure (3).

NOTE: Thermal paste located on the surfaces of the processor (1) and the processor heat sink
(2) must be thoroughly removed and replaced each time the processor heat sink is removed.
Replacement thermal paste is included in the processor heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.

Processor
NOTE:

The processor spare part kit includes replacement thermal material.
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Description

Spare part number

2nd Generation Intel® Core™ processors, (support Intel Turbo Boost Technology) (includes replacement thermal
material):
i7-2620M, 2.7 GHz (turbo up to 3.4 GHz) dual-core processor, 4 MB L3 cache, 4 threads, 35W

657844-001

i7-2630QM 2.0 GHz (turbo up to 2.9 GHz) quad-core processor, 6 MB L3 cache, 8 threads, 45W

657849-001

i7-2720QM, 2.2 GHz (turbo up to 3.3 GHz) quad-core processor, 6 MB L3 cache, 8 threads, 45W

657846-001

i7-2820QM, 2.3 GHz (turbo up to 3.4 GHz) quad-core processor, 8 MB L3 cache, 8 threads, 45W

657848-001

i7-2920XM, 2.5 GHz (turbo up to 3.5 GHz) quad-core extreme processor, 8 MB L3 cache, 8
threads, 55W

657850-001

2nd Generation Intel® Core™ i5 processors, (support Intel Turbo Boost Technology) (includes
replacement thermal material):
i5-2520M, 2.5 GHz (turbo up to 3.2 GHz) dual-core processor, 3 MB L3 cache, 4 threads, 35W

657845-001

i5-2540M, 2.6 GHz (turbo up to 3.3 GHz) dual-core processor, 3 MB L3 cache, 4 threads, 35W

657847-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45)

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the fan/graphics board heat sink assembly (see Fan/graphics board heat sink assembly
on page 68).

10. Remove the processor heat sink (see Processor heat sink on page 73).
Remove the processor:
1.
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Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise, until you hear a click.
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2.

Lift the processor (2) straight up and remove it.
NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.

Display bezel
Description

Spare part number

Display bezel for use with computer models with a webcam

652522-001

Display bezel for use with computer models without a webcam

652523-001

Before removing the display bezel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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Remove the display bezel:
1.

Remove the screw covers (1) and the two Torx M2.5x8.0 screws (2) that secure the display
bezel to the display enclosure.

2.

Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom edge (3) of
the display bezel until the bezel disengages from the display enclosure.

3.

Remove the bezel from the display enclosure (4).

Reverse this procedure to install the display bezel.
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Display panel
Description

Spare part number

43.9 cm (17.3 in), HD+ AG LED WVA

652520-001

43.9 cm (17.3 in), FHD AG WVA

652521-001

Before removing the display panel, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the display bezel (see Display bezel on page 77).

Remove the display panel:
1.

Position the computer display-side up with the front toward you. Open the display as far as
possible.

2.

Remove the four Torx M2.5x6.0 screws (1) that secure the bottom corners of the display
brackets to the display enclosure.

3.

Remove the two Phillips M2.5x2.5 screws (2) that secure the top corners of the display brackets
to the display enclosure.

4.

Position the display assembly down toward the keyboard (3), almost closing the lid so the
display panel hovers above the keyboard.

5.

Lift the display enclosure (4) away from the display until the display cable is visible.

6.

Remove the tape (5) that attaches the display cable to the display panel.
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7.

Disconnect the display cable (6) from the display panel

8.

Remove the eight Phillips M2.0x3.0 screws (1) that secure the display panel brackets to the
display panel.

9.

Remove the display panel (2).

Reverse this procedure to reassemble and to install the display panel.

Webcam module
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Description

Spare part number

Webcam module with microphone

642795-001
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Before removing the webcam module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the display bezel (see Display bezel on page 77).

Remove the webcam module:
1.

Disconnect the webcam cable (1) from the display enclosure.

2.

Remove the webcam module from the display enclosure (2).

Reverse this procedure to install the webcam module.

Top cover
Description

Spare part number

Top cover (includes TouchPad)

652536-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

Component replacement procedures

81

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

Remove the top cover:
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1.

Position the computer right-side up, with the front toward you.

2.

Lift up the TouchPad ZIF connector (1) and remove the TouchPad cable (2).

3.

Lift up the TouchPad button ZIF connector (3) and remove the TouchPad button cable (4).

4.

Lift up the fingerprint reader ZIF connector (1) and remove the fingerprint reader cable (2).

5.

Lift up the application board ZIF connector (3) and remove the application board cable (4).
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6.

Remove the power button board cable (5).

7.

Position the computer upside down, with the front toward you.

8.

Remove the four Phillips M2.5x4.0 screws inside the battery bay and the two Phillips M2.5x4.0
screws in the optical drive/upgrade drive bay (1).

9.

Remove the eight Torx M2.5x6.0 screws (2) that secure the base enclosure to the top cover.

10. Position the computer right-side up.
11. Grasp the top cover by the hole in the optical disk drive/upgrade drive bay and lift up the front
edge of the top cover (1).
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12. Remove the top cover from the base enclosure (2).

13. If it is necessary to replace the TouchPad:
a.

Remove the three screws (1) securing the TouchPad to the top cover.

b.

Release the TouchPad from the clips (2) securing the TouchPad to the top cover.

c.

Remove the TouchPad (3) from the top cover.

Reverse this procedure to install the top cover and TouchPad.
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Display assembly
NOTE: The display assembly spare part kit includes the display panel cable, 3 WLAN antenna and
cables, and 2 WWAN antenna and cables.
Description

Spare part number

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color with webcam (not available with HP
Mobile Broadband)

652519-001

43.9 cm (17.3 in), FHD AG RGB LED UVWA Dream Color without webcam (not available with HP
Mobile Broadband)

652518-001

Display Hinge Kit

652528-001

Display hinge covers

652529-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the display bezel (see Display bezel on page 77).

Remove the display assembly:
1.

Position the computer right side up with the display open and the front toward you.
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2.

Remove the tape (1) that secures the display cable to the system board. Remove the display
cable (2) from the system board. Remove the webcam module (3) from the system board.

3.

Remove the Phillips screw (1) that secures the VGA port to the base enclosure. Lift the port (2)
up at an angle to remove it (3).
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4.

Position the computer upside down. Remove the tape (1) that secures the WLAN and WWAN
cables to the system board. Feed the WLAN and WWAN cables through the hole next to the
keyboard screw (2).

5.

Position the computer right-side up. Remove the WLAN and WWAN cables (1) from the routing
clips (2) in the base enclosure and the system board.

6.

Remove the two interior Torx screws (3) that secure the hinge cover to the base enclosure.
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7.

Position the computer with the rear toward you.
CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.
a.

Remove the four Torx M2.5x7.0 screws (1) that secure the display hinges to the base
enclosure.

b.

Remove the four Torx M2.5x3.0 screws (2) that secure the hinge cover to the base
enclosure.

c.

Remove the display assembly (3) from the base enclosure.

8.

Remove the display panel (see Display panel on page 79).

9.

If it is necessary to replace the display hinge cover:
a.

88

Rotate the display hinge cover (1) around the display assembly cables.
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b.

Remove the display hinge cover (2).

10. If it is necessary to replace the display cable:
a.

Remove the display cable from the left corner (1) of the display cable channel.

b.

Disconnect the display cable (2) from the light sensor in the webcam, and then remove the
display cable.

Component replacement procedures

89

11. If it is necessary to replace the webcam cable:
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a.

Remove the Phillips screw (1) from the routing channel. Slide the routing channel to the
right and lift up. Remove the webcam cable from the channel (2).

b.

Disconnect the webcam from the connector (1).

c.

Disconnect the webcam cable (2) from the webcam.

d.

Remove the webcam cable (3).
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12. If it is necessary to replace the WLAN antennas and:
a.

Remove the WLAN antennas (1) from the display enclosure. The antennas are attached to
the display enclosure with tape.

b.

Remove the WLAN (2) from the display enclosure. The are attached to the display
enclosure with tape.

c.

Remove the WLAN antennas and (3) from the display enclosure.

13. If it is necessary to replace the WWAN antennas and:
a.

Remove the WWAN antennas cables (1) from the display enclosure. The antennas are
attached to the display enclosure with tape.

b.

Remove the WWAN antennas (2) from the display enclosure. The antennas are attached to
the display enclosure with tape.
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c.

Remove the WWAN antennas assembly (3) from the display enclosure.

14. If it is necessary to replace the display latch hooks:
a.

Remove the two Phillips M2.0x3.0 screws (1) that secure the display latch hooks to the
display enclosure.

b.

Remove the display latch hooks (2).

Reverse this procedure to reassemble and to install the display assembly.
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Power button board
Description

Spare part number

Power button board

652515-001

Before removing the power button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45)

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

Remove the power button board:
1.

Position the top cover upside down with the front toward you.

2.

Remove the two Phillips M2.5x3.0 screws (1) that secure the power button board to the top
cover.

3.

Remove the tape (2) that secures the power button board cable to the top cover.

4.

Slide the power button board cable (3) out from the clips in the top cover to remove it.
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5.

Lift the power button board (4) to remove it.

Reverse this procedure to install the power button board.

Application button board
Description

Spare part number

Application button board

652516-001

Before removing the application button board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).
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Remove the application button board:
1.

Position the top cover upside down with the front toward you.

2.

Remove the two Phillips M2.5x3.0 screws (1) that secure the application button board to the top
cover.

3.

Slide the application button board cable (2) out from the clip in the top cover.

4.

Remove the application button board (3).

Reverse this procedure to install the application button board.

Fingerprint reader
Description

Spare part number

Fingerprint reader

655545-001

Before removing the fingerprint reader, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45)

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).
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7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

Remove the fingerprint reader:
1.

Position the top cover upside down with the front toward you.

2.

Peel off the tape (1) that secures the fingerprint reader to the top cover.

3.

Lift the fingerprint reader (2) from the top cover.

4.

Slide the fingerprint reader cable (3) out from the clips in the top cover.

5.

Remove the fingerprint reader (4).

Reverse this procedure to install the fingerprint reader.

Audio/USB 2.0 board
Description

Spare part number

Audio/USB 2.0 board

652517-001

Before removing the Audio/USB 2.0 board, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45),

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).
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7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

Remove the audio/USB 2.0 board:
1.

Position the computer right-side up with the front toward you.

2.

Disconnect the speaker cable (1) from the audio/USB 2.0 board.

3.

Remove the three Phillips M2.5x3.0 screws (2) that secure the audio/USB 2.0 board to the base
enclosure.

4.

Lift the left edge (3) of the audio/USB 2.0 board to disconnect it from the system board.

5.

Remove the audio/USB 2.0 board (4) at an angle to the left from the base enclosure.

Reverse this procedure to install the audio/USB 2.0 board.
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Speaker assembly
Description

Spare part number

Speaker assembly

652540-001

Before removing the speaker assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the Smart Card reader (see Smart Card reader on page 51).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 96).
Remove the speaker assembly:
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1.

Remove the two Phillips M2.5x6.0 screws (1) that secure the speaker assembly to the base
enclosure.

2.

Gently flex the band on the base enclosure (2) next to the speaker assembly.
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3.

Remove the speaker assembly (3).

Reverse this procedure to install the speaker assembly.

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 652545-001. See Modem module cable
on page 101 for information on replacing the modem module cable.
Description

Spare part number

56K V.92 1data/fax modem

628824-001

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).
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9.

Remove the Smart Card reader (see Smart Card reader on page 51).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 96).
Remove the modem module:
1.

Position the computer right-side up with the front toward you.

2.

Remove the two Phillips M2.0x3.0 screws (1) that secure the modem to the system board.

3.

Disconnect the modem cable (2) from the modem.

4.

Remove the modem (3) from the system board.

Reverse this procedure to install the modem module.
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Modem module cable
NOTE:

The modem module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the modem module cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the Smart Card reader (see Smart Card reader on page 51).

10. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 96).
11. Remove the modem module (see Modem module on page 99).
Remove the modem module cable:
1.

Position the computer right side-up with the front toward you.

2.

Remove the modem cable (1) from the routing clips in the base enclosure.

3.

Loosen the Torx M2.0x3.0 screw (2).
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4.

Gently pry the modem jack (3) out from the base enclosure.

Reverse this procedure to install the modem module cable.
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Card reader/USB 3.0 board
Description

Spare part number

Card reader/USB 3.0 board

652514-001

Before removing the card reader/USB 3.0 board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

Remove the card reader/USB 3.0 board:
1.

Position the computer right-side up with the front toward you.

2.

Remove any plastic blanks in the card reader slots.

3.

Remove the three Phillips M2.5x3.0 screws (1) that secure the card reader/USB 3.0 board to the
base enclosure.

4.

Lift the right side (2) of the card reader/USB 3.0 board to disconnect it from the system board.
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5.

Remove the card reader/USB 3.0 board (3) to the right away from the base enclosure.

Reverse this procedure to install the card reader/USB 3.0 board.

Bluetooth module cable
NOTE:

The Bluetooth module cable is included in the Cable Kit, spare part number 652545-001.

Before removing the Bluetooth module cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 103).

Remove the Bluetooth module cable:
1.

Position the computer right-side up with the front toward you.

2.

Disconnect the Bluetooth cable (1) from the system board.
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3.

Remove the Bluetooth cable (2).

Reverse this procedure to install the Bluetooth module cable.
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Network cable and jack
NOTE:

The network cable is included in the Cable Kit, spare part number 652545-001.

Before removing the network cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the display assembly (see Display assembly on page 85).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 68).
11. Remove the processor heat sink (see Processor heat sink on page 73).
Remove the network cable:
1.

Disconnect the network cable (1) from the system board.

2.

Flex the sideband (2).

3.

Remove the two Phillips M2.0x3.0 screws (3) that secure the sideband to the base enclosure.
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4.

Remove the network cable (4) from the base enclosure.

Reverse this procedure to install the network cable.

Power connector cable
The power connector cable is included in the Cable Kit, spare part number 652545-001.
Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the display assembly (see Display assembly on page 85).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 68).
11. Remove the processor heat sink (see Processor heat sink on page 73).
Remove the power connector cable:
1.

Disconnect the power connector cable (1) from the system board.
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2.

Remove the power connector cable jack (2) from the base enclosure.

Reverse this procedure to install the Power connector cable.

System board
NOTE:

All system board spare part kits include replacement thermal material.

NOTE: Models that support quad-core processors have four memory slots. Models that support
dual-core processors have two memory slots.
Description

Spare part number

For use in all countries and regions except the People's Republic of China and Russia:
●

For use with computer models equipped with Intel quad-core processors

652509-001

●

For use with computer models equipped with Intel dual-core processors

652508-001

For use only in the People's Republic of China and Russia:
●

For use with computer models equipped with Intel quad-core processors

655025-001

●

For use with computer models equipped with Intel dual-core processors

655024-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).
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5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the display assembly (see Display assembly on page 85).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 68).
11. Remove the processor heat sink (see Processor heat sink on page 73).
12. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 96).
13. Remove the speaker assembly (see Speaker assembly on page 98).
14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 103).
When replacing the system board, be sure that the following additional components are removed
from the defective system board and installed on the replacement system board:
●

SIM (see SIM on page 45)

●

Bluetooth module and cable (see Bluetooth module on page 47 and Bluetooth module cable
on page 104)

●

WLAN module (see WLAN module on page 48)

●

WWAN module (see WWAN module on page 49)

●

RTC battery (see RTC battery on page 50)

●

Primary memory modules (see Primary memory module on page 62)

●

Expansion memory modules (see Expansion memory module on page 63)

●

Graphics board (see Graphics board on page 72)

●

Processor heat sink (see Processor heat sink on page 73)

●

Processor (see Processor on page 75)

●

Modem module (see Modem module on page 99)

Remove the system board:
1.

Disconnect the network cable (1) from the system board.

2.

Disconnect the power cable (2) from the system board.

3.

Press in on the ExpressCard slot bezel (3) to release it from the ExpressCard slot.

4.

Remove the ExpressCard slot bezel (4) from the ExpressCard slot.

5.

Remove the four Phillips M2.5x3.0 screws (5) that secure the system board to the base
enclosure.

6.

Remove the two hex M2.5 screw locks (6) that secure the system board to the base enclosure.
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7.

Remove the system board (7) by lifting it straight up.

Reverse this procedure to install the system board.

Security lock
The security lock is included with the base enclosure assembly, spare part number 652535-001.
Before removing the security lock, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 45).

5.

Remove the service access cover (see Service access cover on page 46).

6.

Remove the optical drive (see Optical drive on page 58) or upgrade bay hard drive (see Upgrade
bay hard drive on page 60).

7.

Remove the keyboard (see Keyboard on page 65).

8.

Remove the top cover (see Top cover on page 81).

9.

Remove the display assembly (see Display assembly on page 85).

10. Remove the fan/graphics board heat sink (see Fan/graphics board heat sink assembly
on page 68).
11. Remove the processor heat sink (see Processor heat sink on page 73).
12. Remove the Audio/USB 2.0 board (see Audio/USB 2.0 board on page 96).
13. Remove the speaker assembly (see Speaker assembly on page 98).
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14. Remove the Card reader/USB 3.0 board (see Card reader/USB 3.0 board on page 103).
15. Remove the system board (see System board on page 108).
Remove the security lock:
1.

Position the computer right-side up with the front toward you.

2.

Remove the Torx T9M2.5×6.0 screw (1) that secures the security lock to the base enclosure.

3.

Remove the screw (2) that secures the security lock to the base enclosure.

4.

Rotate the the security lock (3) away from the base enclosure and remove the security lock from
the base enclosure (4).

Reverse this procedure to install the security lock.
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5

Computer Setup

Windows Vista and Windows 7
Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter BIOS Setup.

3.

Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

3.

Use a pointing device or the arrow keys to select File > Restore defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu
Select

To do this

System Information

●

View identification information for the computer and the
batteries in the system.

●

View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostics

Displays the following information:
●

System Information
◦

Identification information for the computer and the
batteries in the system.

◦

Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

●

Start-up Test–Verifies the system components needed
for starting the computer.

●

Run in Test–Runs a comprehensive check on system
memory.

●

Hard Disk Test–Runs a comprehensive self-test on any
hard drive in the system.

●

Memory Test–Runs a comprehensive test on any
memory installed in the computer.

●

Battery Test–Runs a comprehensive test on any
batteries installed in the computer.

●

Error Log–Displays a log file if any errors have
occurred.

Restore defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Restore the BIOS security settings to the factory default.

Ignore changes and exit

Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE:

Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Administrator Tools
Setup BIOS Administrator Password

Set up a BIOS administrator password

User Management (requires a BIOS administrator password)
Create New BIOS User Account

●

Select from a list of BIOS users.

●

Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools
Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft
AT-P

Enable/disable Anti-Theft Protection.

DriveLock Passwords

●

Enable/disable DriveLock on any computer hard drive
(enabled by default).

●

Change a DriveLock user password or master
password.

●

Enable/disable the prompt for the DriveLock user
password prompts when restarting the computer.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
Automatic DriveLock

Enable/disable Automatic DriveLock support.

TPM EMBedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
EMBedded Security for ProtectTools. For more information,
refer to the ProtectTools software
NOTE: You must have a setup password to change this
setting.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive, secondary hard drive, or the drive in the upgrade
bay.
CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE:

Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.

Boot Options

●

Set a Startup Menu delay (in seconds).

●

Set the MultiBook Express Boot Popup delay in
seconds.

●

Enable/disable Custom Logo.

●

Enable/disable Display Diagnostic URL (enabled by
default).

●

Enable/disable CD-ROM boot (enabled by default).

●

Enable/disable SD Card boot (enabled by default).

●

Enable/disable floppy boot (enabled by default).

●

Enable/disable PXE Internal NIC boot (enabled by
default).

●

Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

●

Set the Legacy Boot Order.

●

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

Device Configurations

◦

Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦

Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

●

Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

●

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

●

Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (enabled by default).

●

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:
◦

AHCI (Advanced Host Controller Interface)

◦

IDE (Integrated Drive Electronics)

◦

RAID (select models only)
NOTE: Availability of these options varies by
computer model.
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Select

To do this

Device Configurations (continued)

●

Enable/disable secondary battery fast charge (enabled
by default).

●

Enable/disable HP QuickLook (select models only)
(enabled by default).

●

Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

●

Enable/disable HP QuickWeb (enabled by default).

●

Enable/disable HP QuickWeb Write Protect (disabled by
default).

●

Enable/disable Virtualization Technology (select models
only; disabled by default).

●

Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

●

Multi Core CPU (enabled by default).

●

Intel HT Technology (enabled by default).

●

Enable/disable Wake on USB (enabled by default).

●

Enable/disable Num lock state at boot (disabled by
default).
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Select

To do this

Built in Device Options

●

Enable/disable the wireless button state (enabled by
default).

●

Enable/disable eMBedded WLAN device radio (select
models only; enabled by default).

●

Enable/disable the eMBedded Bluetooth device radio
(enabled by default).

●

Enable/disable the LAN (enabled by default).

●

Enable/disable LAN/WLAN switching (disabled by
default).

●

Set the wake on LAN state. Options include the
following:

Port Options

◦

Disabled

◦

Boot to Network

◦

Follow Boot Order

●

Enable/disable the ambient Light Sensor.

●

Enable/disable the Notebook Upgrade bay device
(enabled by default).

●

Enable/disable the fingerprint device (enabled by
default).

●

Enable/disable the integrated camera (enabled by
default).

●

Enable/disable the Power Monitor Circuit (enabled by
default).

●

Enable/disable the audio device (enabled by default).

●

Enable/disable a modem device (enabled by default).

●

Enable/disable the microphone (enabled by default).

●

Enable/disable the speakers and headphones (enabled
by default).

NOTE:

NOTE: All port options are enabled by default.

●

Enable/disable the serial port.

●

Enable/disable the parallel port.

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.
CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.
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●

Enable/disable the 1394 port.

●

Enable/disable the ExpressCard slot.

●

Enable/disable the Smart Card slot.

●

Enable/disable the eSATA port.

Select

To do this

AMT Options

●

Enable/disable Firmware Verbosity.

●

Enable/disable AMT Setup Prompt (Ctrl-P).

●

Enable/disable USB Key Provisioning Support.

●

Enable/disable Unconfigure AMT on next boot.

●

Select Terminal Emulation Mode.
◦

ANSI

◦

VT100

●

Enable/disable Firmware Progress Event Support.

●

Enable/disable Initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults

Restore the default security settings.

Windows Vista and Windows 7 119

6

Specifications

Computer specifications
Metric

U.S.

Width

41.70 cm

16.40 in

Depth

27.20 cm

10.70 in

Height (front to back)

3.70 cm to 4.30 cm

1.47 in to 1.68 in

Weight

3.60 kg

7.96 lbs

Dimensions

Input power
Operating voltage

19.5 V dc @ 4.74 A – 120 W

Operating current

4.74 A

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Operating

10% to 90%

10% to 90%

Nonoperating

5% to 95%

5% to 95%

Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

Relative humidity (noncondensing)

Maximum altitude (unpressurized)

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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43.9 cm (17.3 in) WVA display specifications
Metric

U.S.

Width

24.4 cm

9.65 in

Depth

38.1 cm

15.0 in

Diagonal

43.9 cm

17.3 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Backlight

LED

Character display

80 × 25

Total power consumption

6.0 W

Viewing angle

+/-65 horizontal, +/-50° vertical (typical)

Dimensions

Hard drive specifications
750 GB*

500 GB*

320 GB*

Height

9.5 mm

9.5 mm

9.5 mm

Width

7.0 mm

7.0 mm

7.0 mm

Weight

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

Single track

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

Logical blocks

1,250,242,867

976,752,240

625,121.433

Disk rotational speed

7200 rpm

7200 rpm

7200 rpm

Dimensions

Seek times (typical read, including setting)

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
specifications
Applicable disc

Read:

Write:

BD-ROM, BD-ROM-DL, BD-R, BD-RDL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVDR, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and
mode 2), CD-ROM XA (mode 2, form 1
and form 2), Photo CD (single and
multiple sessions), CD Extra, CD-R,
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, DVD-R,
CD-R, and CD-ROM

Access time

BD

DVD

Random

< 230 ms

< 180 ms

Cache buffer

4.5 MB

Data transfer rate
2X BD-RAM

9 MB/sec

8X DVD

2,400 KB/sec

16X CD-R

2,400 KB/sec

16X CD-RW

2,400 KB/sec

Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HDROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time

CD

DVD

HD

Random

170 ms

170 ms

230 ms

Cache buffer

8 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec
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Applicable disc

Read:

Write:

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

1X BD-ROM

4,500 KB/sec

1X BD-R read

4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode

DVD±RW SuperMulti Double-Layer Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD, Video
CD), Multisession CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CDRW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Cache buffer

2.5 MB

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec
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Applicable disc

Read:

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Write:

DVD-ROM Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD,
Video CD), Multisession CD (Photo cD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVDRAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 110 ms

< 130 ms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

3,600 KB/sec
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7

Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only)

●

Backing up individual files and folders

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.

Save the document.

●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition or the HP Recovery partition.
To check for the Windows partition, select Start > Computer.
To check for the HP Recovery partition, click Start, right click Computer, click Manage, and
then click Disk Management.
NOTE: If the Windows partition or the HP Recovery partition is not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right click
Computer, click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

128 Chapter 7 Backup and recovery

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Be sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD,
go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.
The Backup and Restore Center provides the following options:
●

Backing up individual files and folders

●

Backing up the entire hard drive (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.
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3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.

Save the document.

●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to back up your entire computer (select models only) or your
files.
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition or the HP Recovery partition. To find
the partitions, select Start > Computer.
NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section.

3.

Restart the computer, and then press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.
NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.
NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section.

3.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Be sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone numbers booklet included with the computer.
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows Vista operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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8

Power cord set requirements
The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC
The 3 conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

COC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzlerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3 conductor, 1.0 mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3 conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3 conductor, 1.00 mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3 conductor, 0.75 mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3 conductor, 0.75 mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.
This section provides disassembly instructions for the display assembly. The display assembly must
be disasseMBled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel 3.
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.
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16. Turn the display panel upside down.
17. Remove the backlight frame from the display panel.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index
Symbols/Numerics
1394 port, identifying

14

A
AC adapter, spare part numbers
31, 32, 33
accessory battery connector
identifying 17
ambient light sensor
identifying 15
ambient light sensor board
spare part number 28, 37
Antenna Kit
spare part number 28, 33
application button board
removal 94
spare part number 23, 33, 94
audio in (microphone) jack 13
audio, product description 2
audio-out (headphone) jack 13
audio/USB 2.0 board
removal 96
spare part number 23, 33, 96
B
base enclosure
spare part number 24, 34
battery
removal 45
spare part numbers 25, 32, 45
battery bay
identifying 17
battery light 12
battery release latch
identifying 17
Blu-ray Disc ROM with SuperMulti
DVD±R/RW DL Drive
specifications 122
Blu-ray R/RE DVD±RW SuperMulti
Double-Layer Drive
precautions 39
spare part number 24, 29, 34,
58
specifications 122

Blu-ray ROM DVD±RW SuperMulti
Double-Layer Drive
spare part number 24, 29, 34,
58
Bluetooth compartment
identifying 17
Bluetooth module
removal 47
spare part number 24, 32, 47
Bluetooth module cable
illustrated 26
removal 104
Bluetooth module compartment
cover
removal 47
bottom cover release latch
identifying 17
buttons
calculator 10
center TouchPad 7
left TouchPad 7
optical drive eject 13
pointing stick 7
power 9
QuickWeb 10
right TouchPad 7
TouchPad 7, 9
volume mute 9
wireless 9
C
Cable Kit
contents 26
spare part number 26, 34
cables, service considerations 39
calculator button, identifying 10
calculator light 8
caps lock light, identifying 8
card reader/USB 3.0 board
removal 103
spare part number 103
chipset, product description 1
components
bottom 17
display 15

front 12
left side 14
rear 16
right side 13
top 7
computer feet, locations 44
computer part number 19, 43
computer specifications 120
connector
docking 17
power 16
connector, service
considerations 39
CRT board
spare part number 23, 28, 37
D
diskette drive
precautions 39
display assembly
removal 85
spare part numbers 21, 33, 85
display bezel
removal 77
spare part numbers 27, 33, 77
display enclosure
spare part number 28
display hinge covers
spare part number 33
Display Hinge Kit, spare part
number 27, 33
display latch
spare part number 28
Display Miscellaneous Kit
spare part number 28
Display Miscellaneous Kit, spare
part number 34
display panel
product description 1
removal 79
spare part number 33, 37, 79
display panel cable
spare part number 28, 33
Display Panel Support Kit
spare part number 28
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display release latch 12
Display Rubber Kit
spare part number 34
Display Rubber Kit, spare part
number 28
Display Screw Kit
spare part number 28, 33
display specifications 121
DisplayPort, identifying 14
docking connector
identifying 17
docking support, product
description 4
drives, preventing damage 39
DVD-ROM Drive
precautions 39
spare part number 24, 29, 34,
58
specifications 124
DVD±RW and CD-RW SuperMulti
Double-Layer combo Drive
precautions 39
specifications 123
DVD±RW SuperMulti DoubleLayer Drive
spare part number 24, 29, 34,
58
specifications 123
E
electrostatic discharge 40
eSATA port, identifying 14
esc key, identifying 11
Ethernet, product description 3
ExpressCard slot
identifying 14
spare part number 31
ExpressCard slot bezel
illustrated 30
ExpressCard socket
spare part number 34
external media cards, product
description 3
external monitor port 13
F
fan
removal 71
spare part number 23, 34, 71
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fan/graphics board heat sink
assembly
removal 68
spare part number 23
spare part numbers 34, 68
feet, locations 44
fingerprint reader
identifying 10
removal 95
spare part number 23, 37, 95
fn key, identifying 11
function keys
identifying 11
G
graphics board
removal 72
spare part numbers 24, 33, 72
graphics, product description 1
grounding equipment and
methods 42
H
hard drive
precautions 39
product description 2
removal 54, 56
spare part numbers 25, 29,
32, 33, 54, 56
specifications 121
hard drive cover
illustrated 30
removal 55
Hard Drive Hardware Kit
spare part number 31, 33
hard drive upgrade bay
spare part number 31, 37
heat sink
spare part numbers 37
hinge
spare part number 27, 33
hinge cover
illustrated 28
I
integrated numeric keypad,
identifying 11
integrated webcam light
identifying 15
internal display switch 15

internal microphones
identifying 15
J
jacks
audio in (microphone) 13
audio-out (headphone) 13
network 14
RJ-11 (modem) 16
RJ-45 (network) 14
K
keyboard
product description 4
removal 65
spare part numbers 21, 34,
35, 36, 37, 65
keypad, integrated numeric 11
keys
esc 11
fn 11
function 11
num lk 11
Windows applications 11
Windows logo 11
L
latch
battery release 17
bottom cover release 17
lights
battery 12
calculator 8
caps lock 8
mute 8
num lock 8
power 8, 12
QuickWeb 8
TouchPad 8
webcam 15
wireless 8, 12
M
mass storage device
spare part numbers 29
mass storage device, spare part
numbers 25
Media Card reader, identifying 12
memory module
product description 1

removal 62, 63
spare part numbers 24, 32,
62, 63
memory module compartment
identifying 18
microphone
product description 2
spare part number 28, 37
miscellaneous parts
spare part numbers 31
Mobile Broadband Module
identifying 18
model name 1
modem module
product description 2
removal 99
spare part number 23, 32, 99
modem module cable
illustrated 26
removal 101
mute light, identifying 8
N
network cable
illustrated 26
removal 106
spare part number 24
network jack, identifying 14
num lk key, identifying 11
num lock light 8
O
operating system, product
description 5
optical drive
identifying 13
precautions 39
product description 2
removal 58
spare part number 34
spare part numbers 24, 29, 58
specifications 122, 123, 124
optical drive bracket
spare part number 29
optical drive compartment cover
illustrated 30
optical drive eject button,
identifying 13
P
packing guidelines 41

plastic parts 38
Plastics Kit
contents 30
spare part number 30, 37
spare part numbers 30
pointing device
product description 4
pointing stick 7
pointing stick buttons 7
ports
1394 14
DisplayPort 14
eSATA 14
eSATA/USB 2.0 combo 14
external monitor 13
product description 4
USB 2.0 13, 14
USB charging 13
power button board
removal 93
spare part number 23, 33, 93
power button, identifying 9
power connector
identifying 16
power connector cable
illustrated 26
removal 107
spare part number 24
power cord
set requirements 135
spare part numbers 31, 32
power light 8, 12
power requirements, product
description 4
processor
product description 1
removal 75
spare part numbers 23, 37, 75
processor heat sink
removal 73
spare part number 34
spare part numbers 73
processor heat sink, spare part
numbers 23
product description
audio 2
chipset 1
display panel 1
docking support 4
Ethernet 3

external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
microphone 2
modem module 2
operating system 5
optical drives 2
pointing devices 4
ports 4
power requirements 4
processors 1
product name 1
security 5
serviceability 6
solid state drive 2
video 2
wireless 3
product name 1, 19, 43
product number 19, 43
Q
QuickWeb button, identifying 10
QuickWeb light 8
R
removal/replacement
preliminaries 38
procedures 43
RJ-11 (modem) jack
identifying 16
RJ-11 (modem) jack cover
illustrated 30
RJ-45 (network) jack, identifying
14
RTC battery
removal 50
spare part number 24, 33, 50
S
Screw Kit
spare part number 31, 34
security cable slot, identifying 14
security lock
removal 110
spare part number 24
security, product description 5
sequential part numbers 32
serial number 19, 43
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service access cover
removal 46
spare part number 25, 34, 46
service considerations 38
service tag 19, 43
serviceability, product
description 6
SIM slot
identifying 17
SIM, removal 45
slots
ExpressCard 14
security cable 14
Smart Card cover
spare part number 34
Smart Card reader
removal 51, 53
spare part number 25, 37, 51
Smart Card reader cover
spare part number 25
solid-state drive
precautions 39
product description 2
spare part numbers 25, 29,
37
speaker assembly
removal 98
spare part number 23, 34, 98
speakers
identifying 18
speakers, identifying 12
specifications
Blu-ray Disc ROM with
SuperMulti DVD±R/RW DL
Drive 122
Blu-ray R/RE DVD±RW
SuperMulti Double-Layer
Drive 122
computer 120
display 121
DVD-ROM Drive 124
DVD±RW SuperMulti DoubleLayer Drive 123
hard drive 121
optical drive 122, 123, 124
static-shielding materials 42
system board
removal 108
spare part numbers 23, 33,
37, 108
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T
tools required 38
top cover
removal 81
spare part number 23, 33, 34,
81
TouchPad
buttons 7
identifying 7
spare part number 23
TouchPad on/off button,
identifying 7, 9
TouchPad on/off light, identifying
8
transporting guidelines 41
U
upgrade bay
identifying 13
upgrade bay hard drive
removal 60
spare part number 60
spare part numbers 34
USB 3.0 board
spare part number 23
USB board
spare part number 33
USB port, identifying 13, 14
V
vents
identifying 16, 17
vents, identifying 14
video, product description 2
volume mute button, identifying

9

W
warranty period 19, 43
webcam 15
identifying 15
removal 80
spare part number 28, 33, 80
webcam cable
spare part number 28, 33
webcam light
identifying 15
Windows applications key,
identifying 11
Windows logo key, identifying 11

wireless
identifying 18
product description 3
wireless antenna
spare part number 33
wireless antennas
identifying 15
wireless button
identifying 9
wireless lights 8, 12
WLAN antenna and cables
spare part number 28
WLAN antennas, identifying 15
WLAN module
removal 48
spare part numbers 24, 32, 48
workstation guidelines 41
WWAN antenna and cables
spare part number 28
WWAN antennas
identifying 15
WWAN module
removal 49
spare part numbers 25, 32,
33, 49

